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Homepage 
Homepage Layout: Please be aware of too much white space. If you have too many announcements or too 

many upcoming events it causes the right-hand column to go long and lots of white space in the middle. 

You can solve this in a couple ways: lessening the number of upcoming events that show and/or lessening 

the number of announcements you list. Think about potentially making announcements news articles, or 

make sure you’re not putting big clip art in your announcement section.  Ideally, all of the content will line 

up on the bottom of the homepage. 
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School Homepage Guidelines 
School News: 

 Always have at least two articles displaying on your school homepage and no more than six. (We 
can post articles for you! See submission form below) 

 When adding article thumbnail (image next to article), resize the image to somewhere in the region 
of 120 x 180. To keep the image from warping, you can use Pixlr.com to crop and/or resize your 
image before uploading it Schoolwires. (We can also do this for you if you use the submission form. 
Think horizontal, not vertical when choosing pics for your thumbnail images)  

 

This is what we want: 

 

 By maintaining 2, 4, or 6 articles on your homepage they will align with the other homepage 
sections. 

 Note: Thumbnail graphics are similar in size also helping with the alignment of articles 
 

This is what we don’t want: 

 

 By maintaining an even number 
of articles and setting your 
thumbnails to the correct size on 
your homepage you can avoid the 
big sections of white space. 
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Website Support: 
 In an effort to help you maintain your school homepage and website, the Communications 

Department has created a submition form. Use this form to give us the information we need to 
complete the following tasks: 

o Post a news article 
o Create/Resize rotator photos 
o Create new website page 
o Edit or add content to existing page 
o Other tasks  

 

Link to form: http://bit.ly/1OrVYY4 

 

Website Maintenance Reminders: 
 

 Do not duplicate announcements and news articles.  
 Keep your school calendar updated with events 

  

http://bit.ly/1OrVYY4


Page 7 
 

Section A 
Upload Rotating Homepage Images to a Multimedia Rotator app 

First, size the images accordingly. 

Pixlr 
https://pixlr.com/web 

 

Launch Web App 
Select either Browse (allows you to select an image you want to edit) or Collage (allows you to have a 

collage of pictures) and then select the image(s) you want to edit.  

1. If you select Browse you will navigate to the image you want to add to the rotator.  

2. If you select Collage you will select the pictures that you want to add to the collage picture. 

The image will open in Pixlr. 

1. Click Adjustment to open the menu. 

https://pixlr.com/web
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Resize 
1. Click on Resize. The picture must be 727 x 321 to fit correctly in the rotator. 

 

2. Resize to 727 X 321. You must first set the width of the picture to 727. 

3. Click Apply. 
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Crop 
Now you must crop the picture to meet the size requirements for the rotator.  

4. Click on Crop in the Adjustments menu. 

 

5. Drag the handles to adjust the height of the picture. Be careful to not adjust the width while 

dragging the handle.  

6. The picture Width should be 727 with the picture Height 321.  

7. Click Apply. 
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Save 
Now you will save the image.  

8. Click on the Save button in the upper left hand corner. 

 

9. Rename your picture. DO NOT add spaces in a file name. You can use _ or a dot. You can add a 

number or change the name. I usually add sized to the name.  You don’t want to lose your original 

picture.  

10. Set the Quality to 100%. 

11. Click Save.  

 

You now have a picture sized for your webpage rotator.  
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Add Records to Rotator 

1. In Site Manager, navigate to your Workspace   The Summary tab displays. 

2. Click Homepage to get to the edit mode. 

3. Double-click the Multimedia Rotator app to open it. 

 

4. Click New Record to add a new image file. 
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5. Add a Title for the file. Decide whether to Hide the title or not. 

6. Type a Caption if you want one. Decide whether to Hide the title or not.  

7. Click Upload Image and browse to the file to upload. 

8. Select the file you want to upload, click Open.  You are returned to the Upload window and you see 
the image you selected. 

9. You can also choose to Link Image or Embed a Video. Check the box to activate these options. 

10. Make sure that the Activate on my page is checked or you won’t see the image on your webpage. 

11. Click Save. 

 

Click on New Record to add additional records. 
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Teachers and Staff 

UMRA Updating Teachers & Staff Information for Schoolwires 
You have available a UMRA form to use for updating, adding or changing your Teachers & Staff list for the 

MSD Website. You have will use the Staff Directory Form link to get an updated .csv file to update your 

webpage. 

 

Double-click the UMRA Forms Computers icon on your desktop. 

Staff Directory Form 

1. To get the most recent Teachers & Staff list for your school, click on the Staff Directory Form link. 
In this screen you will see: 

2. A list of your teachers & staff.  

 Name 

 Job Title 

 Email 

 Phone Number 

 Website 

 Include in Export 
3. Exclude from Export button and Remove Exclude button 

Use these buttons to exclude an employee from displaying on the website or to remove the 
exclusion. 

4. Export Users to file 

This will export a list of users who have not been excluded from the list.  

 The list will export to your W drive under the name “UsersExport” and the date (ex: UsersExport01-
01-2016.csv) 

 

This is the file you will import in Schoolwires for your Teachers & Staff page (see below). 
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Edit  
 Go to Site Manager in Schoolwires 

1. Click on Teachers & Staff in the left navigation pane 
2. Click on Your School Teachers and Staff link (Staff Directory). 
3. Click on Your School Staff Directory Page link (Staff Directory). 

 

 
 
 
 
You will see the Flex Editor App with some code in the  
window. This is the code for the Minibase App that 
 you will be editing. Leave the code in the window. 
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4. Click on the Tools tab. 
5. Click on Minibase tool link. 

 

 
 
6. With Minibase App selected under App Manger, click on Staff Directory under App Instances. 
7. Click Edit in Details. 
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Find the record you want to edit or delete and click the appropriate button. 
9. To Edit, locate the user you need to edit. 
10. Click the Edit button. 
11. Make the necessary changes and SAVE. 
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New 
 Go to Site Manager in Schoolwires  

1. Click on Teachers & Staff in the Channels pane on the left hand side.  

2. On the Summary tab click on Staff Directory in the Sections area or add a New Section.  

 

3. Click on Staff Directory on the Current Pages Page.  
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You will see a blank App page.  

 

4. Click on the Tools tab. 

5. Click on Minibase. 
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6. Make sure that Minibase App is selected. 

7. Click on New. 

8. Add an App Name in the Add Minibase App’ dialog box. 

9. Click Save. 

 

10. With the new New App selected click on the Edit button. 

 

Add fields to your new Minibase. These fields need to match the headers in the .csv file you will be using. 

Leave any unused fields blank.  
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11. Enter the first Field Names for each field. 

 

 

12. Click Options to have additional layout choices.  
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13. In the General tab, you can edit the app name, choose to show the App Name on the page, edit 

how many records show per page and choose a display format. 

14. If you make any changes, click Save.  
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15. On the Fields tab, you will decide which fields will be searchable, how users will be able to search 

these fields, the order in which the results of the search will display and whether the field will be 

viewable by everyone. If you make any changes click Save. 

a. Click Edit under Viewers to determine who will be able to view each field. If you do not 

specify, the general public will be able to see each field.  

b. To make the field searchable, enter Filter Type. You can choose from: 

i. None: this is the default and it means that field will not be searchable.  

ii. Free Form: this means that a visitor may enter a letter or letters to search for an 

item. This type of filter is useful when you have a lot of data to search.  

iii. Drop Down: this means that the visitor may choose from a list of items for the 

search. This type of filter is usually used for a short list of data.  

c. To determine the Sort Order for displayed data if you have that field searchable, choose 

one of these. 

i. Ascending order  

ii. Descending order 

d. Choose a Sort Level of fields in the display. For example, you might want to display by 

Phone first, then by Name. You can have up to four sort levels.  

 

16. Click Save if you make any changes. The Records window will return as the active window.  
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17. Click Set Fields & Continue 
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18. Click Import. Step 1 of the Import wizard displays.  

19. Click Browse. Browse your computer for the CSV file you created. Select the CSV file. 

20. Click Next. Step 2 of the Import wizard displays. You can preview your imported records or cancel 

the import. 

21. Click Import. A message appears in the lower left hand corner letting you know your upload was 

successful. The Records window will return as the active window. The records you just imported 

will be in the record database.  
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Deploy the MiniBase 
Once you have created your Minibase, you will need to deploy it.  

 To embed a Minibase app you already created to a page… 

1. Place your cursor where you want the MiniBase. 

2. Click the Insert MiniBase icon. The Add Existing Apps window displays. 

3. Click the By Type tab. 

4. Choose MiniBase from the drop-down list. 

5. Select the appropriate MiniBase.  

6. Click Save.  

7. You will see something similar to [$APP ID=245$] in the Editor. The ID number is a specific number 

assigned to that MiniBase. 
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UMRA Updating Website Information for Schoolwires 
 

You have available a UMRA form to use for updating, adding or changing the Teacher’s website for the 

Teachers & Staff list for the MSD Website.  

These instructions are for teachers to follow. This will add the website address to the file that is used to 

update the Teachers & Staff webpage.  
 

Open the UMRA Forms Computers icon on your desktop. 

Click: Display website address on MSD website 

Website Address 

If you want to add a web address to a teacher’s information on the Teacher & Staff webpage, click on the 

Display website address on MSD website link. 

In this screen you will see: 

1. No Site Set (or the set website)  
2. Reset to no website 

Removes a website if one is set for this teacher. You won’t see this action as it is happening in the 
backend. You can add a new web address or it will remain blank in the backend (or Refresh the 
page to see the change). 

3. The area to add the teacher’s website address. 
4. Set Address 

Loads the teacher’s website to the backend for uploading to the Teachers & Staff information. 
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How to Create Good Filenames for Your Web Pages 
 
Practical Considerations to Naming Your Web Files 

1. Avoid Spaces in Your Filenames 
One of the common beginner's mistakes when naming filenames is to put spaces in the filenames.  

Avoid this problem by not using spaces at all in your filenames. Filenames with spaces work fine on 

your own hard disk. When you create files for the web, the mistakes that can happen with space-

filled filenames is just not worth the trouble. 

2. Use Only Small (Lowercase) Letters 
The simplest way to avoid problems is to just stick to using small letters (lowercase) in your 

filenames. 

3. Put a Descriptive Title or At Least the Main Keywords from the Title in Your Filename 
A filename with your title, or at least the main keywords from your title, serves at least 2 

purposes: 

a. Users can tell what the page is about from the filename 

b. Search engines can guess what your page is about from the filename 

However, it probably isn't a good idea to make your filenames excessively long. Lengthy web 

addresses have their own problems, which leads me to the next point. 

4. Keep the Names Reasonably Short 
Although most operating systems allow extremely long filenames, it's best not to make them 

excessively long. 

You may want to restrain yourself from creating overly long filenames, no matter how descriptive 

you think they may be.  

5. Separate the Words in Your Filenames with Hyphens 
Since you shouldn't use spaces in your filenames, how should you separate the words? The 

hyphen character is regarded by search engines as a word separator. As such, it is a good 

character to use as a word separator. 

Incidentally, you should not use the underscore character ("_") to separate words. Although the 

underscore visually separates words to humans, at this time, many search engines just see it as 

another letter of the alphabet.  
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Calendar 
The calendar within the Site Workspace is the calendar for the main or district site. Only a Site Director or a 

Homepage Editor of the main site may access and edit this calendar.  

The calendar within the Subsite Workspace is the calendar for that subsite. Only a Site Directory, a Subsite 

Director for that subsite or a Homepage Editor for that subsite may access and edit this calendar.  

1. In Site Manager, navigate to the workspace containing the homepage calendar you want to edit.  

2. Click the Calendar on the Summary tab. The calendar displays. 
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Adding an Event 
There are three ways to add events to your calendar.  

 Click the New Event button 

 Double click on the day you want to add an event 

 Click Import Events 
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New Event Button 
1. Access the calendar from the appropriate workspace. The calendar will open to the Calendar tab.  

2. Click on the New Event button. A New Event window will display. Notice it has seven tabs. 

3. On the Event tab: 

a. Enter a date for the event. The format for the date must be mm/dd/yyyy (required). 

Clicking in the date box displays a calendar that you can use to select a date. 

b. Enter an Event Title (required). 

c. Enter the Start and End Times for the event (optional – defaults will apply). The event Start 

Time defaults to 8 AM and End Time defaults to 9 AM. Use the drop-down boxes or check 

boxes to adjust the Start and End times for the event. If you choose All Day, not Start or 

End Times display for the event. If you choose No End time, only a Start Time displays for 

the event.  

d. Enter a descriptions of the event (optional). 

e. Select a category for this event from the drop-down list (optional). This will color code the 

event according to the categories set up by a Site Administrator. 

f. If you are a Site Directory or the Homepage Editor for the main site and you want to make 

the event mandatory, click in the check box to the left of Mandatory Event (optional). A 

mandatory event will display on all calendars. A Mandatory Event icon  will display to the 

left of the event on the calendar. Subsite Directors, Homepage Editors for subsites and 

Section Editors cannot make an event mandatory.  

g. Select Force this event to display in Upcoming Events from today until the event occurs to 

override Upcoming Events App options associated with the calendar (optional).  
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4. Click on the Recurrence tab if you want to set a recurrence pattern and range. 

a. Activate the Make this event recurring check box.  

The Recurrence tab displays Recurrence Patter and Recurrence Range options. 

b. Select a Recurrence Pattern. 

c. Specify a Recurrence Range. You can end after a number of occurrences or specify an End 

by date. Note that the End by date is not included in the range. If you specify the 25th as the 

End Date, the range actually ends at midnight on the 24th. 
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5. If your event will require registration, click on the Registration tab (optional). 

a. Activate the Turn on registration for this event check box to expand the Registration tab. 

b. Enter the registration information for the event. There are two required fields. 

 Maximum number of seats 

 Last date of registration 

c. If you have questions you would like attendees to answer, enter them here. These 

questions can be customized for registered events.  

 
 

6. Click on the Location tab if you want to provide location information. 

Activate the Add a map of this location to your event to include the ability for website visitors to 

obtain step-by-step driving directions. 

Be sure to include a zip code for the event location. If users have entered their zip codes into their 

profiles, this will enable the calculation of the distance to the event for each user.  
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7. Click on the Contact tab if you want to enter contact information. If you activated registration, 

Contact Name and Email are required.  

If website addresses (URLs) are applicable, enter them (optional). 

You can copy and paste a URL from the address bar. Be sure to separate multiple URLs with a 

semicolon.  

 

8. Click on the Post to Calendars tab if you want to submit a request to post your event on additional 

calendars.  

Activate Post event to other calendars to expand the Post to Calendars window.  

 To request the event be placed on the parent calendar, check the box next to the name of 

the parent calendar. 

 To request the event be placed on multiple calendars, click on the Add Collections button. 

A dialog displays showing sets of destination calendars that were created by the Site 

Administrator.  

o Select the desired collection or collections. 

o Click Add Collections. 
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9. If you want to limit who can see an event, click the Viewers tab (optional).  

You can assign viewing rights to either a group of users or to individual users by clicking on either 

the Assign Group or Assign User buttons. By default all website visitors will be able to view the 

calendar event.  

10. Click the Save button. The Calendar tab will return as the active window. The event you added will 

display on the calendar.  

If you make an event a registered event, the Registered Event icon  will display to the left of the 

calendar event.  

 

11. If you want to attach files, click on the Attachments tab (optional). This tab displays only after you 

save the event the first time. Save and then edit the event to access the tab.  
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Double Click on a Date to Add an Event 
1. Double click on the date on which the event will occur. As you can see, the start date will be the 

date that you selected (required). 

2. Enter the Start and End Times for the event (optional – defaults will apply). The event State Time 

defaults to 8 AM and the End Time defaults to 9 AM Use the drop-down lists or check boxes to 

adjust the Start and End Times. 

If you choose All Day, no Start or End Times will display for the event. If you choose No End Time, 

only a Start Time will display for the event.  

3. Enter an Event Title (required). 

4. Enter a Description. 

5. Choose a category for the event from the drop-down list (optional). This will color code the event 

according to the categories set up by a Site Directory.  

6. If you are a Site Director or the Homepage Editor for the main site and you wish to make the event 

mandatory, click in the check box to the left of Mandatory Event (optional). Again, a mandatory 

event will display on all calendars. 

This option will only display if you are adding an Event on the calendar on the main site.  

7. Click on the Save button. The Event will display on the calendars in Site Manager and the end-user 

website.  
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Importing Events to a Calendar 
 

Preparing the CSV File 
You can import events using a comma separated value (CSV) file. During the import, you are required to 

map the fields to your CSV file to the Schoolwires calendar fields. These are the calendar fields you can 

map.  

 Start Date (required field) 

 Start Time 

 End Date 

 End Time 

 Event Title (required) 

 Event Description 

 All Day Event 

 No End Time 

 Contact  

 Contact Email 

 Contact Phone 

 Location 

 Category 

 Registration 

 Maximum Number of Seats 

 Last Day to Register 

You cannot import recurring events. You will need to add these events to the calendar manually or add all 

of the dates for the event in the CSV file. 

Prepare the CSV file and save it to your computer. You can download a sample file from within the Import 

Events tab and then modify it to include the events you want to import. 

When specifying a category for an event use the Category ID number, which you will find on the Event 

Categories tab.  
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Export an Outlook Calendar to CSV File 
 

Outlook – Preparing your file 

 Click on the File tab. 

 Select Open & Export 

 Import/Export 

 

 Export to a file 
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 Comma Separated Values 

 

 Select Calendar  
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 Browse to your preferred save location.  

 Name the file. 

 Click OK. 

 Click Next 

 

 Click Finish 
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 Select the date range for the export.  

 

 

Locate the CSV file that you just exported.  

 Delete any events that you don’t want to appear on your Schoolwires calendar. 

 Add a column and add the categories for the events on the calendar. 

 Save the updated file as a CSV file. 
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Import the CSV File 
1. Click on the Calendar App. The app opens.  

2. Navigate to the Import Events tab. Click Import Events. 

 

3. Click Browse and select your calendar import file.  

4. Click Open.  
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5. Click Next.  

 

6. Match the Calendar Field to the Map to CSV File Field in the drop-down list. The Event Name, Start 

Date and End Date are required. By default New Custom Mapping displays in the Import Mappings 

drop-down. If you want to use a previously created custom mapping, chose it from the drop-down 

list.  

7. If you use the default of New Custom Mapping, all the Map to CSV File Fields display as Ignore. Use 

the drop-down lists to select the fields from the import file you wish to map to the Calendar fields.  

You do not need to map all of the fields. The only two fields that must be mapped are Start Date 

and Event Title. 

8. Click Next. Apply settings as desired.  
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9. Click Import. The Import tab will return as the active window. The import you just completed will 

display in the list. 

a. If the import encounters errors during processing, a View Exceptions button displays. Click 

View Exceptions in an easy to read format.  

b. If you need to roll back the import at any time, click on the Undo Import button.  

 

  



Page 44 
 

Categories 
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Section B 
This section contains the links that are in the header of the homepage.  

 

The process to add the links is the same for both Students and Parents.  

The Staff and Community links are created by the administration and shared with each site. You cannot edit 

these links.  

Students App – From the Homepage Page click on the Students app in the B section.  
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1. Click New Link to add a new quick link to the page. 

2. Click the Edit button to edit the link properties as needed. 

3. Click Delete to delete a quick link. 

4. Click the Organize Links button to organize the links. 

5. Click the Options button for additional options.  
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Quick Links 
In Site Manager, navigate to the workspace containing the Students links. HomepageStudents 

Double-click the Students App  

 Click one of the links to edit  

1. Link Text: Add the Link Text as it will appear. This is mandatory. 

2. Web Address: Paste the web address for the link OR Browse to the link on this website. 

3. Select Target: will it open in the same window or a new window. 

a. New window is the best practice if the page will open off of this website. 

4. Tooltip: Text that will appear if the user hovers over the link. 

5. Parent Link: Select if you want the link to be under another link. 

6. Auto Expand: The menu will display all of the links (sublinks).  

7. Activate on my page. 

8. Save 
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Imagery 
This feature allows you to add an image instead of a text link. 

1. Link Image: Browse to find the image you want to use for the link. 

2. Height: Width: Most icon images should be approximately 50 x 50. 

3. Rollover Image: Browse to find an image that will display when a user rolls over the link image.  

a. This image will use the same size that the original image is. 

4. Display Bullet Image: Displays a bullet in front of the text or image 

5. Activate on my page: Shows this link on your page 

6. Save 

 

  



Page 49 
 

Viewers 
By default, all website visitors can view this shortcut. You can limit who is able to view it by adding specific 

users or groups. 

 

 

Organize Links 
1. Change your link order by clicking the Sort A-Z button to sort alphabetically.  

 

2. To manually set the sort order you can sort your link order by dragging a link and dropping it when 

you see a think green line in the location where you would like it to reside.  
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3. To nest a link, drag it on top of another link and drop it when you see the green plus sign.  
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School News 
Medford School District News – shared 

News App Name: If you don’t have any “School News” articles, hide the app name. This way your 

homepage won’t say “School News” with no news underneath it. You will still have content there in the 

way of District News. Put “School News” back up if you add an article. If you have a newsworthy item, but 

don’t have time to post it—send it to Natalie! She’d be happy to post news articles to your site. 

Add a Record to the Headlines & Features App 
1. In Site Manager, navigate to the workspace containing the page with the app you wish to edit. 

Double click on the app. 

 

2. The app opens on the Summary tab. 

3. Click New Headline. The New Headline window displays. 

 

4. On the Headline tab, enter a title for the headline, which is a required field. 

5. You may enter Teaser Text, an Accent Image, Alt Text for the image as well as display Start and End 

dates and times. 

Resize the image to somewhere in the region of 120 x 180. 
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6. Use the Headline Body tab to enter headline detail. 
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7. Use the Author tab to enter the name, phone number and email address of the author. 

 

8. Use the Viewers tab to limit who may view this Headlines & Features record. By default, all website 

visitors will see the record. To limit who may view the record, click the Assign Group or Assign User 

buttons to search for and select specific users and groups. 

 

9. Use the Tags tab to enter a comma separated list of tags for this headline. Tagging allows for the 

categorizing and filtering records. 

10. Use the Activate on my page check box to change the status of the Headlines & Features record. By 

default, the check box is checked and the record is active on the page. 

11. Click Save. The headline is added and you are returned to the workspace. 

 



Page 54 
 

School Announcements 

Add a File Link in an Announcement 
 

1. In Site Manager, navigate to the Announcement you wish to add the link to.  

 

2. Click the New Announcement button. The Announcement dialog displays.  

3. Enter the Title for your New Announcement. This title will only display in some areas.  

4. Copy the title and paste into the Announcement body. Add any additional text you want to display. 

Format the text as desired.  
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5. On the Display Duration tab, enter a Start Date and an End Date (optional). 

 

6. On the Viewers tab, use Assign Group and Assign User to add Viewing Rights to this announcement. 

By default, the announcement will be seen by all visitors.  
7. Click Activate on my page for the announcement to display on the website. 
8. Click Save. The announcement is added to the Announcement app and you are returned to the 

workspace.    
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9. Use the Sort Announcements button to put the announcements in your desired order. 

 Click Sort Alphabetically to auto-sort your announcements in alphabetical order. 

 Drag and drag announcements to manually sort into the order you desire.  
10. Click Save. The sort order is updated and you are returned to the workspace.  

11. Click the Options button for additional options. 
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Add a description of your app if desired. 
12. Check the Show the app name on my page if you want the name to display on the Homepage. 
13. Choose between Display all active app records or Display a specific number of active app records. If 

you select the later a record limit box will appear where you can enter the specific number of 

records. 
14. Click Save. 
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Our School 

Newsletter 
1. Find the location of your Newsletter on your website. 

 Quick links 

 Our School 

2. Upload your current newsletter to the website by using the Tools tab. 

 Click on Files & Folders  

 Click on the Upload button 

 Browse to your newsletter and select it and click Open. 

o If you name the file to upload with the same name each month you can upload the 

file and it will update the file on the site. 

3. Click Upload. 

4. Once the file is listed in the Files & Folders window, click on the More button under Actions. 

 Select Get Link from the list.  

 Copy the Full Web Address. 

 Close the Files & Folders window. 

5. Click on the channel or tab(s) to get back to the section where your newsletter is located on the 

website.  

6. Open the page and add your new link address and click Save. 

Twitter/Facebook/Peachjar eflyers 
Facebook Embed: If you have a facebook page and it’s not showing up on your homepage, it’s probably 

because of your privacy settings. Please add webmaster@medford.k12.or.us as an admin so we can make 

your page viewable from the website. Natalie can provide further instruction on how to do this, if you need 

it.  

Peachjar is also automatically updated on the school’s page every time they post a flyer.  

Upcoming Events 
The Upcoming Events app displays events from the calendar that is it associated with. 

The Upcoming Events app has to be associated with a single calendar in the same workspace. It only 

displays the upcoming events for that particular calendar for the time period specified.  
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Best Practices for Apps on Pages 
 

When working with pages, you can change the Page Layout. There are ten layout options from which you 
may choose.  

 
Some layouts are better suited for certain apps or combinations of apps than others. This document 
includes a chart illustrating our layout and app recommendations.  
 
We also include suggestions for app placement within each layout region. 

Apps and Page Layouts Chart Legend  
The legend below is used with the Apps and Page Layouts Chart.  

 R (Recommended)—This is a preferred app and layout combination.  

 L (Some Limitations)—This app and layout combination may display correctly. If you use the app in the 
layout, be sure to check to see how the app looks in the column where you placed it by viewing the page on 
the end-user website.  

 N (Not Recommended)—This app and layout combination could be problematic.  
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Apps and Page Layouts Chart  
This chart illustrates what apps and layouts work best together. You should always check the end-user 

website to ensure that the page layout you selected and apps you placed on the page display properly. This 

chart also addresses stacking apps within a layout and apps appropriate for a home page. 
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Best Practices for Page Layout Regions  
Certain apps display better in certain regions of a Page Layout. For example, a large amount of content 
within an app placed in a region with limited space will cause the app to display awkwardly. Always check 
how your page displays on the end-user website. Adjust your Page Layout as necessary in order to provide 
the best appearance of your content.  
 

 One Column—With a one column layout, any app you place in the column displays standard web 
content without issue. This layout is best for apps containing a large amount of content such as 
blogs or calendars. Apps with less content such as Upcoming Events are better suited for multiple 
column or sidebar layouts.  

  
              One Column Layout with Upcoming Events                                                 One Column Layout with Blog 
  

 

 
 Multiple Columns—With multiple column layouts, you can place apps in each of the columns on 

the page. Many apps display well with these layouts. Apps flagged with an N in the Apps and Page 
Layout Chart are not recommended for multiple column layouts.  

                     
                          Two Column Layout with                                                                     Three Column Layout with  
     Flex Editor, Announcements and Upcoming Events                                Flex Editor, Photo Gallery and Calendar                           
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Trademark Notice  
Schoolwires, the Schoolwires logos, and the unique trade dress of Schoolwires are the trademarks, service marks, trade dress and logos of Schoolwires, 
Inc. All other trademarks, service marks, trade dress and logos used in Schoolwires and the Website are the trademarks, service marks, trade dress and 

logos of their respective owners.     Copyright Notice © 2014 Schoolwires, Inc. All rights reserved. 

Also, it is important to note that for content to align evenly for a multi-column layout, you must apply the 

same formatting to the content within each column. Below you see two end-user views of pages using the 

Three Column layout. On the left, text in all columns is formatted using Heading 1. On the right, text in the 

first column is formatted using Heading 1; text in the second column is formatted using Heading 6; and, 

text in the third column is formatted using Normal. 

   

 


Sidebars—Sidebars are narrow columns that appear on the left and right sides of a Page Layout and are 
used in conjunction with columns. Sidebars are well suited for apps that contain a small amount of content 
such as Upcoming Events or Announcements. Other apps may work well when placed in a sidebar, 
depending on the size and amount of content within in the app.  

 

                 Right Sidebar with Flex Editor (main) and                                 Right Sidebar with Flex Editor (main) and  
                           Upcoming Events (sidebar)                                                                             Blog (sidebar)  
 

 



Headers and Footers—Headers and Footers are one-column regions placed at the top and bottom of a 
Page Layout. Any app placed in a Header or Footer region displays standard web content without issue. 
Page Layouts with Header and Footer regions also contain other regions where you place apps.  
You might want to avoid placing apps with large amounts of content into the Header or Footer regions as 

the focus of a page is typically its central region. The Header and Footer regions are best used to accent the 

central content or to display common information for the page. For example, you might use a Header or 

Footer region to place a title for the page. 
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